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Frontispiece. (Continued on next two pages.) 
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Frontispiece (continued). (Caption on next page.)
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Frontispiece (continued). (Figure shown on previous two pages.) 

A. Seafloor topography of the Hawaiian-Emperor volcanic chain in the northwest Pacific Basin (after Tarduno and Cottrell,
1997; Wessel and Smith, 1998). Leg 197 sites are labeled.

B–D. Histograms of inclination values derived from principal-component analyses of stepwise alternating-field
demagnetization data from lavas recovered at Leg 197 sites (blue). These are compared with a synthetic Fisher distribution
(purple) (Fisher, 1953) having the same precision parameter (k) as the experimental data. Red lines indicate the inclination
value for Hawaii and the calculated inclination value for Leg 197 sites.

E. Plot of Zr vs. Y for all Leg 197 basement shipboard geochemical data compared with Mauna Loa Volcano (data from
Rhodes, 1996).

F. Photomicrograph of the olivine-rich zone in basement Unit 16 (cross-polarized light; field of view = 5 mm) (Sample 197-
1203A-37R-3 [Piece 1A, 10–13 cm]).

G. Photomicrographs of zonation in plagioclase from basement lavas at Site 1203 (cross-polarized light; field of view =
1.25 mm) (Sample 197-1203A-35R-4 [Piece 1F, 47–49 cm]).

H. Photomicrograph of maghemite alteration (white) of primary titanomagnetite (pink) in Site 1204 basalt (reflected light;
field of view = 1.25 mm) (Sample 197-1204B-8R-3 [Piece 8, 55–57 cm]).
I. Close-up photograph of interval 197-1203A-41R-2, 0–17 cm, showing partially altered glassy lobe margins with
calcareous interlobe sediment.
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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
Shipboard Scientific Party, 2002. Leg 197 summary. In Tarduno, J.A., Duncan, R.A., Scholl, D.W., et al., 
Proc. ODP, Init. Repts., 197: College Station TX (Ocean Drilling Program), 1–92.

CD-ROM volume citation:
Tarduno, J.A., Duncan, R.A., Scholl, D.W., et al., 2002. Proc. ODP, Init. Repts., 197 [CD-ROM]. Available 
from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2002. Site 1203. In Tarduno, J.A., Duncan, R.A., Scholl, D.W., et al., Proc. 
ODP, Init. Repts., 197, 1–171 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.
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Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.
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Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 

Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)
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Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 

please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is a space shuttle photograph of the Hawaiian Island chain from Kauai (lower right) 
to the Big Island of Hawaii (upper left). This chain and its extension in a series of seamounts in the 
northwest Pacific form the basis of many of our ideas about geodynamics. Leg 197 tested whether the 
hotspot source currently under the Big Island was drifting in the mantle during the formation of 
volcanic edifices 81–43 m.y. ago (the Emperor Seamounts). Image courtesy of Earth Sciences and 
Image Analysis Laboratory, NASA Johnson Space Center. Photo taken during Mission STS026 (Roll 43, 
Frame 82) and can be found at eol.jsc.nasa.gov.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
http://eol.jsc.nasa.gov
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.
The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 16 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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volume efficient and enjoyable.
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CD-ROM CONTENTS: CHAPTERS
1. Leg 197 Summary
Shipboard Scientific Party

2. Explanatory Notes
Shipboard Scientific Party

3. Site 1203
Shipboard Scientific Party

4. Site 1204
Shipboard Scientific Party

5. Site 1205
Shipboard Scientific Party

6. Site 1206
Shipboard Scientific Party
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs), smear slide data tables, thin section logs, sedimentary thin section 

and thin section data tables, alteration and vein logs, digital core images, and photomicrographs are 
included in this section. ASCII versions of the smear slide data tables are also available (see “ASCII 
Tables”). The photomicrograph log can be found in the PHOTOMIC directory.

Site 1203

Visual Core Descriptions · Smear Slides · Thin Sections · Alteration Log · Vein Log 

Site 1204

Visual Core Descriptions · Smear Slides · Thin Sections · Alteration Log · Vein Log 

Site 1205

Visual Core Descriptions · Smear Slides · Thin Sections · Alteration Log · Vein Log 

Site 1206

Visual Core Descriptions · Thin Sections · Alteration Log · Vein Log 
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of physical properties and ICP major and trace element data and 
all of the of the smear slide data tables presented under “Core Descriptions.” A complete listing of 
the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 

You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 3 Chapter 5  Smear slide data tables 

Chapter 4 Chapter 6 
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Chapter 3, Site 1203
Table T8. Whole-rock major and trace elements for basement rocks determined by ICP-AES, Hole 
1203A.

Table T11. Magnetic susceptibility measurements, Site 1203.
Table T12. GRA bulk density measurements, Site 1203.
Table T13. Natural gamma ray measurements, Site 1203.
Table T14. Thermal conductivity, Site 1203.
Table T15. Index properties, Site 1203.
Table T16. P-wave velocity, Site 1203.

Chapter 4, Site 1204
Table T7. Whole-rock major and trace element abundances in basalts determined by ICP-AES, Site 

1204.

Table T11. Magnetic susceptibility measurements, Site 1204.
Table T12. GRA bulk density measurements, Site 1204.
Table T13. Natural gamma ray measurements, Site 1204.
Table T14. Thermal conductivity measurements, Site 1204.
Table T15. Index properties, Site 1204.
Table T16. Compressional wave velocity measurements, Site 1204.

Chapter 5, Site 1205
Table T8. Major and trace element concentrations in lavas determined by ICP-AES, Hole 1205A.
Table T11. Magnetic susceptibility measurements, Site 1205.
Table T12. GRA bulk density measurements, Site 1205.
Table T13. Natural gamma ray measurements, Site 1205.
Table T14. Thermal conductivity measurements, Site 1205.
Table T15. Index properties, Site 1205.
Table T16. Compressional wave velocity measurements, Site 1205.
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Chapter 6, Site 1206
Table T8. Whole-rock major and trace element abundances in basement rocks determined by ICP-
AES, Hole 1206A.

Table T12. Magnetic susceptibility measurements, Site 1206.
Table T13. GRA bulk density measurements, Site 1206.
Table T14. Natural gamma ray measurements, Site 1206.
Table T15. Thermal conductivity measurements, Site 1206.
Table T16. Index properties, Site 1206.
Table T17. Compressional wave velocity measurements, Site 1206.

Smear Slide Data Tables
Site 1203 smear slide table.
Hole 1204A smear slide table.
Hole 1204B smear slide table.
Site 1205 smear slide table.
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CD-ROM CONTENTS: OVERSIZED FIGURE
The following oversized figure is available on the volume CD-ROM in PDF format.

Chapter 3, Figure F23. A graphic log illustrating the characteristic structures of pahoehoe sheet lobes 
at Site 1203 (Unit 11; Sections 197-1203-32R-2, 5 cm, to 32R-5, 73 cm).

CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary data files presented in ASCII format. The files 
present raw X-ray diffraction (XRD) data values. Supplementary material files are located in the 
SUPP_MAT directory.

XRD_DATA 07R6W57.UDI

XRD_1203
01R1W102.UDI
01R1W124.UDI
02R2W103.UDI
02R2W119.UDI
03R2W128.UDI
03R2W80.UDI
03R2W9.UDI
03R4W49.UDI
04R1W71.UDI
04R2W6.UDI
04R2W6A.UDI
05R2W135.UDI
05R2W35.UDI
07R3W95.UDI
07R5W57.UDI

08R1W97.UDI
08R3W129.UDI
08R3W36.UDI
09R1W119.UDI
09R1W147.UDI
09R2W58.UDI
10R1W25.UDI
10R2W11.UDI
10R2W23.UDI
11R1W74.UDI
11R1W80.UDI
11R4W66.UDI
12R1W24.UDI
12R2W36.UDI
12R2W74.UDI
12R3W73.UDI
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13R1W26.UDI
13R1W74.UDI
13R2W18.UDI
14R1W35.UDI
14R2W120.UDI
14R3W25.UDI
14R3W3.UDI
15R2W75.UDI
15R2W83.UDI
16R2W68.UDI
16R3W65.UDI
16R3W7.UDI
17R2W103.UDI
17R2W29.UDI

32R1W74.UDI
36R1W37C.UDI
36R3W10C.UDI
36R3W29.UDI
36R3W97.UDI
37R2W16.UDI
37R2W28.UDI
37R2W54.UDI
39R4W49.UDI
40R2W26.UDI
41R1W83.UDI
57R1W108.UDI
59R2W51C.UDI
62R3W48C.UDI
17R2W49.UDI
17R2W91.UDI
17R3W15.UDI
17R3W22.UDI
19R5W36C.UDI
20R6W90.UDI
21R1W141.UDI
21R1W70.UDI
25R1W110.UDI
29R1W148.UDI
29R2W137.UDI
29R2W83.UDI
29R3W119.UDI
29R3W128.UDI
31R2W61.UDI
32R1W22.UDI

63R5W130.UDI
63R5W35.UDI
QTZ0714.UDI
QTZ0714A.UDI
QTZ0715.UDI
QTZ0716.UDI
QTZ0717.UDI
QTZ0718.UDI
QTZ0719.UDI
QTZ0720.UDI
QTZ0721A.UDI
QTZ0721B.UDI
QTZ0722A.UDI
QTZ0808.UDI
QTZ0809.UDI
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XRD_1204
02R3W124.UDI
03R1W47.UDI
03R2W97.UDI
12R1W28.UDI
QTZ0728.UDI
QTZ0802.UDI

XRD_1205
06R3W79.UDI
18R5W21.UDI
34R1W85.UDI
35R3W97.UDI

36R1W10.UDI
QTZ0812.UDI

XRD_1206
04R2W92.UDI
06R1W62.UDI
18R1W43.UDI
21R3W28.UDI
36R3W36.UDI
36R3W36A.UDI
QTZ0817.UDI
QTZ0819.UDI
QTZ0820.UDI
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 197 Site Map 

ODP Map (Legs 100–197)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 197 
depth-shifted and processed downhole logging data and shipboard core logging data (color 
reflectance, gamma ray attenuation bulk density, magnetic susceptibility, moisture and density, and 
natural gamma radiation). The downhole logging data are provided by the Borehole Research Group 
at the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory, Columbia 

University, Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-3182; E-mail: 
borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173, 174B, and 175. The indexes are contained 
in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes 
can be searched individually or collectively.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader 4.0.5 installation 
software and instructions for 
different platforms)

197IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR197_01.PDF (Leg 197 Summary)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling location maps)

ODPMAP.PDF (ODP map, Legs 100 through 197)

CHAPTERS
(Volume chapters)

197_MAP.PDF (Leg 197 site map)

IR197_02.PDF (Explanatory Notes)

IR197_03.PDF (Site 1203)

IR197_04.PDF (Site 1204)

IR197_05.PDF (Site 1205)

IR197_06.PDF (Site 1206)

DSDPMAP.PDF (DSDP map, Legs 1 through 96)

TABLES
(Data tables in ASCII format of
smear slide, physical properties,
and ICP major and trace element
data)

IR197_03 (Site 1203)

IR197_04 (Site 1204)

IR197_05 (Site 1205)

S_SLIDES (Sites 1203 through 1205)

README.TXT

OVERSIZE
(Large-format figure)

IR197_03 (Chapter 3 file)

COR_1203.PDF (Site 1203)CORES
(Visual core descriptions, smear
slide data tables, thin section logs
and data tables, alteration logs, 
vein logs, digital core images, 
photomicrographs, and
photomicrograph log)

COR_1204.PDF (Site 1204)

COR_1205.PDF (Site 1205)

IMAGES (PDF files of core images)

COR_1206.PDF (Site 1206)

IR197_06 (Site 1206)

MAC

UNIX

WINDOWS

PHOTOMIC (PDF files of photomicrographs)

XRD_DATA
(X-ray diffraction instrument data)

XRD_1203 (Site 1203 files)

XRD_1204 (Site 1204 files)

XRD_1205 (Site 1205 files)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
Leg 197 Initial Reports)

101NDX.PDF through 173NDX.PDF,
174BNDX.PDF, and 175NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

XRD_1206 (Site 1206 files)

VOLUME
(Leg 197 Initial Reports volume)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

SUPP_MAT
(Supplementary Material)
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